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Introduction

Conventions Used in this Document

This document uses the following conventions:
e The names of screens, windows, fields, and other features displayed by the software are shown

in bold type.
e Information you enter into the software is in bold type, as in the following example: Enter

Miscellaneous in the Amount Type box. E@ﬁ

e Names of keys are shown in capitals; for example, ENTER, TAB. A plus sign (+ two key
names indicates that you should press both keys at the same time; for exam %FT + TAB.

e The names of buttons you can click with your mouse are enclosed in @example, [OK]

and [Post].

2 Helpful information to make your experience better. O&

D NOTE: This symbol draws your attention to informa@™ef particular i Qch as information

not included in steps. Q @
b\ ’Q&

CAUTION: This symbol draws your att&n to informati

you avoid a costly or time-consuming error. O K

._*_. IMPORTANT: This sym*@a S your atte@t%‘ormation that is of critical importance.

03
Ag\ @6‘0
SN

important because it can help
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Introduction

MyAssistant Upgrade Guide

This document steps you through the upgrade and configuration of the Sage 300 CRE MyAssistant software.
If you are installing the MyAssistant software for the first time please refer to the MyAssistant Installation
Guide included with the MyAssistant installation files.

Upgrading the MyAssistant software consists of the following steps:

1. Upgrade the MyAssistant Server software. Q
2. Reactivate the MyAssistant Server software by stepping through the MyAssista
Configuration Wizard.
3. (Optional) Upgrade the MyAssistant Drive Mapper. @
4. Upgrade the MyAssistant software on the workstation computers or Ter rix Servers where

MyAssistant is used.
5. Depending on a number of settings, you may be asked to reactlv ware on the

workstation(s) on first use
Upgrading and configuring the MyAssistant server should take ap y 30 rginutes. Upgrading each
MyAssistant workstation should take approximately 10 minutes b

CAUTION: Itis important that the MyAsss@re is u V|a a supported upgrade
h

path. The following chart outlines the supported 5 based ersion of the MyAssistant
software you are currently running.

To determine what version of the MyAssistanare you are rently running, open the software and
select File > Help > [About]. The windoykthat opens willwo he version of the software.
i e paths.

4.0 and higher ectly to MyAssistant 15.1

Review the table below for the iup

Current MyAssistant Ve

3.x or earlier é de to MyAssistant 4.2, then upgrade to MyAssistant 15.1

If you upgrad%m an unsu“ you risk corrupting your MyAssistant data.

Upgrade Guide Page 6



Introduction

Support and Training
Telephone Support

When you would like to speak to a customer support analyst directly, call us at 800-551-8307. Telephone
support is available Monday through Friday from 6 a.m. to 5 p.m. Pacific Time with the following
exceptions:

e Every Thursday from 2 p.m. to 3 p.m. Pacific time (closed for customer support staff fneetings)

e Standard United States holidays

¢ Quarterly company meetings

Sage Customer Portal S@'
You may log on to the Sage Customer Portal at: \
https://customers.sagenorthamerica.com/irj/portal/anonymous/login. :

The portal provides access to the following services:
o Knowledgebase: Find answers to your questions, access @oads, and scribe to your
articles. This service is available online 24/7.
e Live Chat: Chat online with a customer support anal

hours are Monday through Friday from 6 a.m.
telephone support.

e Online Support Request: If you have a stio n issue t@ t, you can submit an online
support ticket. A support analyst will con#gt you during re@ phone support hours.
Training O

Sage University

Sage University offers both recard training%Q Visit SageU.com for currently available

and upcoming classes. \

How to access MyAssista n%; option&\ niversity:
. Enter www.Sa in your web s bar.

great optio k questions. Chat
acific;l’i , he same exceptions as

1
2. Click [Custo ning] and ct your Sage 300 Product from the list.
3. Inthe pa% ns, click F%ct Training] on the left side of the screen.
4. Click [MyA ant] in thefls opened.
5. Sfleger [Realti a g] or [Replay Leaning] and review the available options in each.
How & omplimentansistant Training in Sage University:
ni®& www.SageU.com in your web address bar.

. jck [Customer Training] and select your Sage 300 Product from the list.
N Click [Complimentary Training] on the left side of the screen.

4. Review the list of complimentary classes for a MyAssistant option.

MyAssistant YouTube Channel
The MyAssistant YouTube channel offers a variety of MyAssistant training videos. Subscribe to the
MyAssistant YouTube channel to be notified when new videos are added.

How to access the MyAssistant YouTube channel:
1. Enter www.YouTube.com/MyAssistantTraining
2. The channel will open with all available videos listed.
3. Click on a video to watch.

Upgrade Guide Page 7
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Introduction

Local Business Partner
Contact your local Business Partner to learn what types of MyAssistant training they can provide.

Before You Begin

e Create a backup of your MyAssistant database prior to upgrading the software.

e Determine the computer where the MyAssistant server software is currently installed. It is most likely
on your Sage 300 CRE server.

e Ensure the latest Microsoft Windows and Microsoft Office updates have been ingfa stalling the
High Priority updates is recommended.

e Gather your MyAssistant Product Keys and Customer Number. E ®
TIP: Restart the MyAssistant server prior to performing the upgra& i will complete any Windows

or other software updates where a restart is required.

Upgrade Guide Page 8



Backup the Database

Chapter 1 — Back Up the MyAssistant Database

Before upgrading your MyAssistant software, it is important that you backup your current MyAssistant
database.

1. Log on to the server where the MyAssistant Server software is installed using a Windows user

that has administrative privileges.

Open the MyAssistant Configuration Manager using the icon on your Desktop (pi
by navigating to Start > All Programs > Sage > MyAssistant > MyAssistant

0

d left), or
tion

Navigate to the tab labeled MyAssistant Database Connection

Click [Backup Database...] (highlighted below)

@ My Assistant Server Configuration Manager = ER

—

Product Activation

| MMy Assiskant Database Connection

Sage 300 CRE Data Folders
Matification E-Mail Accounk

Server Options

2

\

O

Enter the computer tha

Server Mame

Create a usarnan
the SGL Ser

ser Mame

@ase name:
urnber:

Connect to the Mylssistant Databa

Usze the fields below to enter th
and to create a SOL S

W

Advanced @ttings
Inskanc | I5D

password For My Assi

W

0 My Assiskant K
Pagghion

01 Password:

@@\
o @

B

* £
arackers

Mokification

45512

SCCESS

ter name wher crver databasze is installed
SrEr
@s located ‘Q
; N\

Test Settings...

Backup Database. .

Ok,

Upgrade Guide
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Backup the Database

5. Specify the location for where the database backup will be stored by accepting the default

location or using the [...] button to select a location.

@ Backup Database

= =2

=]

| T Create MyAssistant Database Backup.

Select the location ko store the generated backup and click
camplete your backup.

Backup Location:

Backup Mydssistant Database

Ci\Users\AdministratoriDocuments|MyAssistantBackup_06_24_Z014.bak

the button [Backup Mydssistant Database] to

4

6. After selecting the backup file locatio %Backup M§
ill e

7. When the process has complet 6{”
as succes@b:en backed

‘Q

am sage w

8. Atfter finishing, click [OK

7%

&

Now that your MyAssistant d
MyAssistant software.

©
%
QO

Upgrade Guide

nt Database]

at states the backup was successful.

up, continue with the upgrade of your
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Server Upgrade

Chapter 2 — Upgrading the MyAssistant Server

Perform the following to initiate the MyAssistant Server upgrade.

1.

4. The Sage 300 CRE MyAssistant Installation hub will ogen.

Log on to your Sage 300 MyAssistant server with a Windows user that has Administrator or
Unlimited permissions.

Confirm that you have closed all applications and disabled any anti-virus or Firewall software that

the .ZIP file to a folder. Consider saving the .ZIP file to a shared folder so it i ible from any
workstations where MyAssistant will be installed.

Perform the following to initiate the MyAssistant Server Upgrade: \

b) Unzip the files to a folder on the local drive on the MyAssi
c) Open the location of the unzipped MyAssistant installat'%

may be running @
Using the link provided by Sage Software, download the MyAssistant installat'%%: nd save

Sage 300 s\\
Construction and Real Estate O

MyAssistant
/ersicn 15
S @

» View Installa |de

» Install é Q

» In or kstatlo

N =

l SageCRE.com l Exit |

Click [Install Server] to start the MyAssistant Server upgrade.

Upgrade Guide Page 11



Server Upgrade

Step 1 — MyAssistant Server Upgrade

The MyAssistant Installation wizard starts once you have selected the type of install.

m MyAssistant - Setup Server

YWelcome to the Myhssistant Server Instaler

Wialcome

may be asked to restart your system after installing prerequisites.

®  Prerequizites &
®  MyAssistant

Thiz wizard will guide you through the Mpdssistant inztallation proceszs, vou @

Before continuing inztallation, pleasze cloze all ap az Microsoft
Outlook, Wiruz Scanners, and Spware Detector ey ah inkerfere
with the My Aszzistant installation.

.
Click [Next] to continue. Ks Q

<
) &,
.\6 \Q(b

L8

Mewt > Cancel

%
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Server Upgrade

Step 2 — MyAssistant License Agreement

You must accept the Innovative Software Design License Agreement to upgrade the Sage 300 CRE
MyAssistant software. A complete copy of the License Agreement is provided with the MyAssistant installation
files.

m MyAssistant - Setup Server

License Terms for MyAssistant Server

License Terms IMPORTANT - READ CARFEFULLY: Ths

Software License Agreetnent (the “Agreement”) %\

15 a legal agreement between you - either an
individual or a single entity - the (“Licensee™) an

Innovative Software Design, Inc. (CTST@
Agreement applies to the computer so EN

machime readable form, that acco i3

A greement (the “Software] dates,
documentation  and  related =M. Yo1r
AGEEE T BE BOUND BY EM= OF

THIS AGEEEMINT CLICETIG
ACCEPT OF
AGEEEMEITT STALLING, @ :
OF TSI W ARE. Q
PY

OT AGIE, D OT I \
OF T SOFTW. T MAY
EE TO YO ACE OF
i

C FOR AFLLL D
[
Q\Q | accept the terms@ense agreement
% Q@ st > Cancel |
If you agree to the te e Licens@ement, check the | accept the terms in the license agreement
checkbox and clic t] to contin

9
N
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Server Upgrade

Step 4 —-MyAssistant Server Prerequisites (Optional)

This window displays the any prerequisite software that needs to be upgraded.

m My hssistant - Setup Server

Prerequisites for MyAssistant Server

Mudszistant requires the following items to be installed before continuing. Items
with a checkmark are already installed on your system:

Windows installer Update &
Windows NET 3.5 ®

SOL Server Express

Crystal Reports Redistributable &\

[T Donot install SEL Server es
Only check thiz bow if yo eMhztalled your oS stance of SOL Server
Pleasze read the Installation & for more |nfo

s ) g :’ MHest > Cancel

Inztall Prereguisites

%

4 @

II\/IPORT S h|ghly hat you will encounter this screen when upgrading
MyAssistant — the m Ilkely scenffri seeing this screen would be if you are using a full version of the
M|crosoft§ ?

Onl “Do not install SQL Server Express” box if you have separately purchased, installed and

ing a full version of the Microsoft SQL Server database engine. The MS SQL Server edition (i.e.
ull &% Express) is not displayed in the list of installed programs in Windows. Do not check this box if you
are unsure whether you have a full version of Microsoft SQL Server installed. By checking this box you
are taking full responsibility for the installation, setup, and maintenance of the SQL Server instance that
MyAssistant will use.

Upgrade Guide Page 14



Server Upgrade

Step 4 — MyAssistant Software

Determine where the MyAssistant program files will be installed on your server.

m MyAssistant - Setup Server E

[y Assistant Server

The default lazation where the Mudsziztant program filez will be installed
to iz C:\Program Fileshlnnovative Software Designihy Assistanth, You
may uze the Browse button to zpecify a different location on your loc
cormpuker,

Inztall bwdzsistant ®
Select a location o inztall Mudssistang
C:4%Program Files (2861 nnowative e Ezignthdy Az
\: ’Q&
. OQ %)
Accept the default locay se the [Brows tton to specify a different location.

Click [Next] to be%e tallation ?@)dated MyAssistant software.
0\6 Q

Mest > Cancel
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Server Upgrade

Step 5 - You Have Completed Upgrading the MyAssistant Server

Congratulations, you have completed upgrading the MyAssistant Server.

m MyAssistant - Setup Server

fou have completed instaling Mybssistant Server

Congratulations! ou have finizhed installing the Mydssistant Server, The

Myt zsistant Server must be activated and configured to wn. To actwat{

gervel, Iuh the Mpdezsistant Configuration Manager.

Finizhed ®

o
Click [Finish] to close the & nd have t jon to continue to the Configuration Manager.

. NOTE: Y01$! step thro%;onflguratlon Manager on the server before upgrading
MyAssistgnt @y Workstav

L8
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Server Upgrade

Step 6 — Start the MyAssistant Configuration Manager
After clicking Finish, you will be prompted to start the MyAssistant Configuration Manager.

MyAssistant - Setup Server

3 1 Your Myhssiskant Server needs to be configured before it can be
V' used,

Do wou want o run the MyAssistant Configuration Manager now?

Yes

Click [Yes]. Continue to Chapter 4 to walk through reactivating the My.

NOTE: You must step through the Configuration Man n the serve pgrading
MyAssistant on any Workstations. Q
b\ ’Q&

Upgrade Guide Page 17



Additional Settings

Chapter 4 — MyAssistant Server Configuration

This chapter walks through reactivating the MyAssistant Server software. When in the configuration manager,
you can verify that all settings are still accurate. Configuring the server must be completed before upgrading
MyAssistant on any workstations.

Read this section carefully:

You will complete the following steps to configure the MyAssistant Server: &
1. Reactivate the software. ®
2. Upgrade your MyAssistant database.
3. Confirm the prefilled file paths for Sage 300 CRE data folders x
4. Confirm the prefilled Mail Server settings for sending emails are &
5.

Review and modify the MyAssistant Server settings as neede(O

NOTE: Reactivating the software and stepping th/@the Config anager on the

MyAssistant Server will take approximately 10 minute% .

S
& &
&L
@ O
N\
N

Upgrade Guide Page 18



Step 1 - Welcome

Additiona

| Settings

If the MyAssistant Configuration wizard isn’t started, open it with the desktop icon or by following this path:
Windows Start > All Programs > MyAssistant > MyAssistant Configuration Manager.

@ My Assistant Server Configuration W

izard =

E £

| Welcarme

Product Activation

MvAssistant Database Connection
MvAssistant Database

Saqe 300 CRE Data Folders

Maotification E-Mail Accaunt

Welcame To The Mylssistant Server

You may need the following information to configure the My2ssistant Sert@

» Your MyAssiskant cuskomer number and Activation codes

» The Windows password for the Adminiskrator user,

. » 8 Sage 300 CRE Operator ID and password that Myhssi
Server Opkions

S@Xtﬂ arcess Sage 300 CRE da

» The email account which MyAssistant will use to se alnessages,

WS

‘O
Q

5 i

&

Mext =

@

ka,

Cancel

Only check Show%nced Opti %

[ ]
icrosoft SQL Server database.

Upgrade Guide

Are uging a Web Proxy
n%\a full versionof i
GN e to define the Wicrosoft SQL Server credentials that will be used to access MyAssistant

in a prior version of MyAssistant, the information for the items above will already be entered.
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Additional Settings

Step 2 — Product Activation

The MyAssistant Server must be reactivated. The Product Key and Customer Number may be prefilled.

@ Myfssistant Server Configuration Wizard = 3l
Wwelcome Product Activation (7]
| Product Activation | Enter your custamer number and server product key to activate My.&ss@erver.
Myssistant Database Connection Custarner Murnbey K
Myhssiskant Database Server Product Key @
Sage 300 CRE Data Faolders | Use Web Provy Server

Motification E-Mail Account L s e \
Wweb Prowxy Address;
Server Opkions
User MName:
Password: %
Domnain: @ @
Q = Back Mexk = Cancel

If you use a Proxy Server, box displayed under the Server Product Key field and verify that the
informatian is accur

Aickival

%
7

%

NOTE: The Web Proxy Server checkbox will only appear if you selected Show Advanced Options
in the Welcome Screen (Step 1).

If you use a Web Proxy Server, check the box displayed under the Server Product Key field and verify
that the information entered is accurate.

Upgrade Guide Page 20



Additional Settings

Step 3 — Database Connection

D NOTE: This step will only be available if you click [Show Advanced Options] in the Welcome
step.

@ Myassistant Server Configuration YWizard E &3
Welcome Connect o the Mybssistant Databaze K
Product Ackivation Lize the fields below to enter the computer name where th er database
is installed and to create a SOL Server user,

Myassistant Database Connection

Enter the cormputer that the database is located at: \
Mdssistant Database Server Name SERVER]
Sage 300 CRE Data Folders Create a username and password Far My Assistant @ 55

the SOL Server:

Motification E-Mail Account
User Marne My Bssiskant

Server Opkions
Password *********-@
~ . ook A A
Re-enter Password: - Q )
% rackers \\
Advanced Cunnxg Setkings @
(o) o K

Instance @ 15
se name: | Mokificaty
\ niumber: 45
\ ’\0

\\\ K% \OQ

%,
R\
@

$ ION: Making changes in this step can break the connection to the MyAssistant database.
Modifythg these fields requires advanced knowledge of SQL Server database engines. It is highly

recommended that you do not make any changes in this step when upgrading your MyAssistant Server.

< Back Mext = Cancel

This step gives you access to the server name, SQL Server credentials, and SQL Instance and Port
Number MyAssistant uses to connect to the Database.

This step will have all previously entered information prefilled.

Click [Next] to continue.

Upgrade Guide Page 21



Step 4 — Upgrade the MyAssistant Database

Additional Settings
MyAssistant will perform the necessary steps to upgrade your database.
o8l Myassistant Server Configuration Wizard o B =
Wolome My lssistant Database (2]
Product Activation My#Assistant needs to upgrade your database to the newest version, T
a few minutes, Please click Next to proceed with the upgrade.
MyAssistant Database Connection
[ myassistant Database |
Sage 300 CRE Cuta Folders
Motification E-Mail Account

Server Options Updating database: 80% completed. .. O&

\ Q < Back Next > Cancel
Click [Next] to upgra®®@the databa@

Upgrade Guide
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Additional Settings

Step 5 — Sage 300 CRE Data Folders

Verify that the information in this step is still accurate. These are the data folders MyAssistant will be able to
monitor, and the Sage 300 CRE credentials MyAssistant will use to access the data.

@ MyAssistant Server Configuration Wizard @ B 2
P Define Sage 300 CRE Data Folders K L7
Product Activation Enter a Sage 300 CRE operator and passwiord that MyAssista @D access Sage

300 CRE data.

Mwdssistant Dakabase Connection

Sage 300 CRE User: \
Meydssistant Database Sage 300 CRE &

Sage 300 CRE Data Folders password: Shaw charackers Q
Motification E-Mail Account Click. "Add Data Folder" to select the Sage 300 atolders vou fguld like to monitor with

My hssistant,

Server Opkions

Sage 300 CRE Folder Locatig® 2

L Add Daka Folder

< Back Mext = Cancel
6\

[NeN] to continue. If there is more than one data folder entered, you will be prompted to select
whiciNplder you wish to have Database Customizations imported from. If there is only one data folder
specified, Database Customizations will be imported automatically.

If the Sage 300 CRE password entered in this step is set to expire, a warning message will pop up. When
the password does expire, you will need to reopen the MyAssistant Configuration Manager and enter the
new credentials in this step. Updating the settings for this User account in Sage so the password never
expires is recommended.
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Additional Settings

Step 6 — Notification E-Mail Account

Verify your mail server settings are still accurate. Notification emails will originate from the name and email
address specified in this step.

@ Myassistant Server Configuration YWizard = =

Welcome Motfication E-Mail Account @ o

Product Sckivation Lze the following to specify the e-rmal account from which n @&maﬂ

messages will be sent on this server,

My Assistant Database Connection -
Fram Marme: My Assiskant

Mdssistant Database Erom E-mail Address: \
Sage 300 CRE Data Faolders O

Mail Server Settings

Mokification E-Mail Account

Oukgaing Mail Server:
Server Opkions

Username: @

Password: @

A 4
characters
This server rifires an eMtrypred S50 @&

A = Back Mesxk = Cancel
=
N,
The Mai settings will showPwhat was entered the last time the software was configured. If nothing
hg€ chagge, click [Next].
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Additional Settings

Step 7 — Server Options
This final step is used to determine a variety of settings around the MyAssistant Server.

@ MyAssistant Server Configuration Wizard - X

Server Cptons e

Welcame
Product Activation Bl S

MyAssistant Database Duaily Summary can be used to send someone a list of notifications across multiple subjects (Tasks)

Sage 300 CRE Data Folders Deliver summary emails ak; | 4:00 am -
Motification E-Mail Account K

Send Errors To

Server Options
Recipient name:

Recipient email:

\ Browse. ..
Save Sage MyCommunicator Email Messages O

Folder Location:

aukomatically save email associated with MyCommunic &y [0 B
Running Tasks and Sending Service SEttil@
Determine the number of concurrent @ be used tarur& asks and Send emails,

Concurrent processes to run Jasks Jb. Task&\ (=1 60 -
Concurrent processes bo se il 2|3 @I’i Ut in minutes  |[240) 2

Daily Summaries: MyAssistan? mmary e
notifications across several T@ one email

< Back Fimish Cancel

ages are used to send each recipient their
e. See the MyAssistant User Guide for more

information. This time shou er all of: asks have run.

Send Errors To: Som¢og® e notifieggwhenWyAssistant encounters an error. It is recommended to
send error messa @ primary M tant user.

Save MyCo unicator Email S:

Sage My@ %cator for ooRaliows you to centrally track users’ email correspondence related to
your busj ;\ addition to creqgng a record of business-related emails, a copy of the mail messages
ca a nd linked to your Sage data (e.g. Jobs, vendors, customers, etc). To enable this function,
Q} ox in this section and click [Browse...] to select a folder location.

Running Tasks and Sending Service Settings:

MyAssistant runs Tasks, sends emails and updates Sage data with MyCommunicator via background
processes (i.e. Windows Services) on the server. These processes are now scalable to increase
performance, and auto-correct in the event of a hang.
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Additional Settings

These MyAssistant Services (named ISDAdminTaskService and ISDAdminSenderService) start other
processes named “TaskRunner*32,” which each take 30-50Mb of memory when idle. Many variables
affect the system resources used when Tasks run and emails are sent, including:
e The available server memory
o Disk drive performance
e Other server demands at the time the MyAssistant Tasks are run. For example, running Tasks at
night may allow additional server resources to be dedicated to MyAssistant.

Perform the following to determine the optimal number of processes:
e Complete the MyAssistant server configuration with the default settings and the Igtant
workstation installation.
Activate two MyAssistant Tasks you will regularly use.

Use the Windows Task Manager and the Resource Monitor to track serve usage and
disk queue lengths when both Tasks are run concurrently.

e Open the MyAssistant Configuration Manager and increase or d umber or processes
based on available server resources. e&

Click [Finish] to close the MyAssistant Server Configuration Wizard. O

Once the Configuration Wizard is closed, the Server portion of the@

Continue to Chapter 5 to install the MyAssistant kastation@ sistant in@on is complete.
&
(s)\ &

O 0

%\O QQ)

2 O

64 \Q(b"a
&\\\
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Workstation Upgrade

Upgrading the MyAssistant Drive Mapper

If you use a Mapped Drive (i.e., drive letter “T:”) to access your Sage 300 CRE data or programs files, you
need to upgrade the MyAssistant Drive Mapper. The MyAssistant Drive Mapper is used by the Windows
Service that runs MyAssistant Tasks, to access your Sage 300 CRE database or programs.

How do | know if | am using the Drive Mapper?
Perform the following to determine if you are using the MyAssistant Drive Mapper.
1. Log on to the server where the MyAssistant server is installed

2. Open Windows Explorer
3. Go to the folder where the MyAssistant program files are installed. If you acc &[he default

location when installing the software, the MyAssistant program files will be irft owing
location:
C:\Program Files (x86)\Innovative Software Design\MyAssistgqt
4. Look for a file named InnovativeSoftwareDesign.MyAssistant e perCommand.dll in the

MyAssistant, Task Service, or Sender Service folders

If this file exists, you are using the MyAssistant Drive mapper and Iiﬁ. to be updated in all three

locations (the MyAssistant, Task Service and Sender Service prog ers). a

CAUTION: The MyAssistant Drive Mapper m e e;If you gregsi apped drives to access
your Sage 300 data files or Program Files. If you are& UNC patl not use any mapped drives,
you do not need to use the Drive Mapper tool.

Perform the following to upgrade the MyAssi e Mappelg
1. Log on to the computer where { yAssistant se is installed using a Windows user that has
Administrator or Unlimited privigge
2. Open the folder contain yAssist tion files. This will be a location you selected when
saving the files. Ther@ efault locati
3. Using Windows rer, copy and r the file

InnovativeS r¢Design.M sistant.DriveMapperCommand.dll from the Tools >
DriveMapﬂ and folder MyAssistant installation files to the folder where the MyAssistant

software h en installegf! accepted the default location when installing the MyAssistant
softw%,this locatiop v rogram Files\Innovative Software Design\MyAssistant.)
*

& ativeSoftwar@pesign.MyAssistant.DriveMapperCommand.dll also needs to be placed
n ollowing locations:

4
& a. Program Files\Innovative Software Design\MyAssistant\Sender Service
b. Program Files\Innovative Software Design\MyAssistant\Task Service

5. Once you have replaced this file, restart the ISDAdminTaskService and ISDAdminSenderService
from the Windows Services window. Follow the instructions below to do this.

Click to open the Start menu and click [Run]

In the Run box type services.msc to open the Windows Services window
Look down the list for ISDAdminTaskService and ISDAdminSenderService
Restart both of these services.

PonNPE

The MyAssistant Drive Mapper tool is now upgraded.
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Workstation Upgrade

Chapter 5 — Upgrading the MyAssistant Workstation(s)
IMPORTANT: If you are upgrading a Terminal or Citrix Server, please move to Chapter 6.
Perform the following to initiate the MyAssistant Workstation upgrade.

1. Log on to your Sage 300 MyAssistant workstation with a Windows user that has Al pstrator or
Unlimited permissions.

2. Confirm that you have closed all applications and disabled any anti-virus or oftware that

the .ZIP file to a folder on your machine. If accessible from the

may be running
3. Using the link provided by Sage Software, download the MyAssw&% ation files and save
|

files that were used to upgrade the MyAssistant Server. Perfor, lowing to initiate the
MyAssistant Workstation Upgrade.

a) Open the location of the downloaded MyAssistant Inst&n files.

b) Unzip the files to a folder on the local drive on t ssistant S

c) Open the location of the unzipped MyASSI t t|on flles bIe click autorun.hta
open. (

4. The Sage 300 CRE MyAssistant Installa K&

Sage 300

Construction and Re £ Q
MyAssistant @Q
Version 145 % Q

v View tlon Gu

S
\ all WorkstaNon. 7

N\

Install Workstation — Select [Install Workstation] to perform a MyAssistant workstation upgrade.

| SageCRE.com | Exit |

, Yyou can use the same
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Workstation Upgrade

Step 1 - Welcome

When you select Workstation Install on the MyAssistant splash screen, the Setup Workstation wizard will
appear.

m Myhssistant - Setup Workstation

Welcome to the MyAssistant Instaler

Wieloome
Thiz wizard will guide yau through the Mydssistant installation process, @
Inztall Prereqiusites may be azked to restart your system after installing prerequisites.

&  FPrerequisites ®

®  MyAssistant
Befare continuing inztallation, pleaze cloze all Icygn: [such as Microsoft
Outlook, Yirus Scanners, and Spyware Detectiryzin ey can interfere

with the My Assigtant inztallabion. O

Mest > Cancel
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Workstation Upgrade

Step 2 — MyAssistant License Agreement

Read and accept the Innovative Software Design End-User License Agreement. You must accept the
Innovative Software Design License Agreement to use the Sage 300 CRE MyAssistant software.

m Myhssistant - Setup Workstation
License Terms for MyAssistant
Licenze Temms IMPORTANT - READ CAREFUELLY: This
Inztall Preregiusites Software License Agreement (the “Agreement”™)
15 a legal agreement between you - either an
indrndual or a single entity - the (Licensee™) and ®
Innovative Software Design, Inc. ("ISD™).
Aoreement applies to the computer sofages
machine readable form, that accomp S

Agreement  (the  “Software™),

documentation and related  serwo

AGEEE TO BE BOTUND BY To0

THI> AGREEMINT BY “
ACCEFT THE

AGREEMEITT, I3 3, COP

OF TSI G

MCT AGREE& 0] ]NST PY
OR TUSE

TO YOUR
PURC E A FUULL
@pt the terms in the@greement
L g
;O z@ Meut = Cancel |

Click [Next] to cor& @6
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Workstation Upgrade

Step 3 — Prerequisites for MyAssistant Workstation

The next window displays the prerequisite software that MyAssistant may need to upgrade. If there are no
software updates necessary on the workstation, the Setup Workstation Wizard will skip this step. Once all
prerequisites have been installed, click [Next] to continue with the MyAssistant Workstation Install.

4

Click [Next] to begin the installation of updated MyAssistant software on the w@on.

Step 4 — Install the Software

m MyAssistant - Setup Workstation

My Assistant

The default lozation where dud zziztant program files @ s
to is C:\Program Fileshnng @ oftware Design®y 7w
Install Prereqiusites may use the Browse i sty & different | oo local
) computer. % .

Inztall Mydizsiztant \ \\

Browse... |

& \ Mest > Cancel
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Workstation Upgrade

Step 5 - You have Completed Installing MyAssistant

Congratulations. MyAssistant has successfully been upgraded on this machine.

m My Assistant - Setup Workstation

Yol have completed instaling MyAssistant

Install Prereqiuzites Mt zzistant for the firzt time pou will be asked to provide zome basic infor
to activate and connect to the Mydasistant Server.

Finizhed ®

Congratulations! v'ou have finished installing Mopszzistant. When you Iaunch@

@
oy
N\
&
N

Firish |
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Workstation Configuration

Chapter 6 — MyAssistant Workstation Configuration

E] NOTE: Depending on a number of settings, you may not need to reactivate the Workstation. If
this is the case, MyAssistant will open ready to use.

Step 1 — Welcome Screen

Double click on the MyAssistant icon on the desktop to open the MyAssistant software. @
23

@ Mydissistant User Configuration YWizard %
| e | Welcormes To MyAssistant
Product Activation You may need to the following information to confi % t:
Sage 300 CRE Data Folders
Your Settings & four MyAssistant customer number and Activation CDLO

2
Nt

If t shortcut on the desktop, follow the path below to open MyAssistant:

peMghe Windows Start Menu > All Programs > MyAssistant (File) > MyAssistant
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Workstation Configuration

Step 2 — Product Activation

You must activate MyAssistant in order to use it. A working internet connection is required to complete this
step. Your customer number and product key may already be entered. Reactivate before clicking next.

@ Myfssistant User Configuration Wizard o B=OEE
welcome Froduct Activation
| Product Activation | Enter your customer number and user product key to activate My i@r LIser
Adrninistrator on this computer, The Myassistant product key det®goines the
Sage 300 CRE Data Folders Myazsistant features availlable to user Administrator on this co [
Your Settings Zustomer Mumber
My Assiskant Product ey

Web Prowy Settings
Web Proxy fddress: %
User Name: 6
Password: @
Darnain: ® * @
tiva&

Q.Cl.ctiv ke L3Wer
\ '\O @
K Q < Back. Mexk =
@e Web Proxy SWver connection fields will only be available if you clicked [Show Advanced
i Welcome step. Verify the information and click [Next].

| Use Weh Proxy Server &\
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Workstation Configuration

Step 3 — Entering Sage 300 CRE Data Folder Information

The information in this step will be prefilled. Verify that it is accurate.

@ My Assiskant User Configuration Wizard = =R
\Welcome Ciefine Sage 200 CRE Data Folders @
Product Activation Enter your Sage 300 CRE user name and password.,

Sage 300 CRE Data Folders |

Timberline User: |

Your Setki
our 2ettings Timberline password: | \

[] Show characters

Click.in the Sage 300 CRE Location column to specify & der, Wease verify any prefilled
Sage 300 CRE data Folder paths,

Ignore | Sage 300 CRE Folder Locatio | Mame
I Ci\ProgramDatal SAGELT, . | Timberline Construction

QO Q\
@@0 & ..

Click [Next] if |nformat|on iS C

,Q(\\

L 4
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Workstation Configuration

Step 4 — User Profile

This step shows the personal information for the Windows user on this workstation.

@ Mydissistant User Configuration Wizard = 3 2
welcome Your Personal Information
Produck Activation Enter the person's name and e-mail address for the current wWindows Us@

Sage 300 CRE Data Folders

v Sl Windows User: Administrator @
Your Marme:
Your E-mail Address: &\
| Show Matifications in the Sage 300 CRE Desktuo

W | Display Myassistant Alerts in the System
W | Show Myassistant Tile on the Deskkop

6 Q « Back Finish
Sage 300 CRE M%tant will sta@%icking Finish in the wizard.
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Terminal Server Upgrade
Chapter 7 — Upgrading a Terminal Server

CAUTION: This chapter is written for clients who will be running the MyAssistant Server and at
least one MyAssistant User on a Terminal or Citrix Server.

Log onto the Server as a System Administrator.
Run the MyAssistant Server installation to upgrade.

Activate MyAssistant with a Server Product Key.
Log onto the machine with a Windows user who will run the software

Open the MyAssistant user Application. s
Vg t

What is Involved
Here is a list of what needs to be done to upgrade MyAssistant on a Terminal or Citrix &(@

ogkrwnE

Depending on a number of settings, the user may need to reacti oftware.

given to specific files. Find a list below of these files. The default ave bee ided for your

convenience below, however they may vary slightly. @ @
If on Windows 2008: . &
e C:\Program Data & \\

Before Upgrading
Before MyAssistant can be upgraded on any accounts other than \%‘ministrato ermissions must be
pat e%

e C:\Program Flles\lnnovatwe Sof e Design

e C:\Program Flles(x86)\lnnov oftware De &

If on Windows 2012: Q Q

e C:\Program Da

e C:\Program % ative Soft esign

e C: \Progra& 86)\Inno oftware Design
IMPORTA*ermlsyon@ be given to these folders prior to activating any MyAssistant

users on ghis

the MyAssistant Server

Server.

Activating the MyAssistant Workstation
Once the MyAssistant Server is upgraded and configured, log onto the Terminal or Citrix Server as the
Windows user who will be using the MyAssistant software.

e Ifthere is a MyAssistant icon on the desktop, double click to open the User Configuration

Manager.
e |If there is not an icon on the desktop follow this path:
Start > All Programs > Sage > MyAssistant (folder) > MyAssistant

When the User Configuration Manager is open complete the steps in Chapter 6 to activate the
MyAssistant workstation.
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Test the upgrade

Chapter 7 — Test the Upgrade

The last step in the upgrade process is to confirm that MyAssistant is working properly. Perform the
following to test this:

Access Sage 300 CRE Data

Open the MyAssistant Designer software from a MyAssistant workstation.

Open an activated MyAssistant Task.

Move to the Email step in the Edit Task window.

On the right side of the window is a list of available Sage 300 CRE database rec @
Expand the very first record.

Right click on the first field and select [Browse Data].

The data contained in the field should be displayed in the Browse Data wi

Troubleshooting
1. Perform the following if data is not displayed in the Browse windo
a. Select File > [Options] to open the Options window. Q

Nogakrwbdr

b. Move to the Sage 300 CRE Data Folder step.
c. Click [Test Connection] to confirm that the Sage 300 dentialgentered are able to
access the Sage 300 CRE data. If the test fails, enter u ed crede

2. Contact support if an error is displayed when browsi@ta

Run Tasks and Receive Email Messa \Q . @
1. Open the MyAssistant software from a sSEyawworkstati@g.
2. Browse to an activated Task. If possible 3gelect & Task wit ed Crystal Report that is
being sent to you (edit the recipient lisjs ded). @
3. Right click on the Task and click [Ru @ Send]. K

N\

Troubleshooting
1. If the Task doesn’t finish ru
a. Log onto the MyAs8igt

b. Open the Windo s window un > type: Services.msc).
c. Look forthe IS ask and | Sender services. Confirm both are started.
2. If the Task fini ning but an em not received:
a. Openth ws Servic gpdow (Start > Run > type: Services.msc).
b. Look ISDAdmIn rvice. Right click on the service and select [Properties].

c. Click the [Eog On]tab
de % [This ac enter a Windows user that is associated with a person who is an
& fistrator in theNgage 300 CRE software.
Q k [OK] and then réstart the Service.
&If e report is not attached to the email

a. Perform the steps outlined for #2 above

Upgrade Guide Page 38



Conclusion

Conclusion

This completes the upgrade of the Sage 300 CRE MyAssistant software. The next step is to learn your way
around the updated software. Please refer to the User Guide for information on using MyAssistant.
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